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Preface

About This Guide

This guide explains how to install the Xilinx® Integrated Software Environment (ISE) 7.1i 
software and how to use the Xilinx online documentation. 

Information on technical support and known issues of the ISE 7.1i release are also 
included.

Guide Contents
This guide covers the following topics:

• Chapter 1, “Introduction,” provides details about the contents of the CDs in your 
software package, as well as the operating system, equipment, and system memory 
requirements needed to install and use the software.

• Chapter 2, “Installation Instructions,” describes how to install the Xilinx software 
tools, online documentation, and ModelSim Xilinx edition, as well as how to set up 
the system environment.

• Chapter 3, “Known Issues,”describes the most critical Known Issues in the ISE 7.1i 
release at press time.

• Chapter 4, “Software Service and Support,” describes how to find up-to-date 
information about Xilinx products.

Additional Resources
For additional information, go to http://www.xilinx.com/support. The following table 
lists some of the resources you can access from this website. You can also directly access 
these resources using the provided URLs.

Resource Description/URL

Tutorials Tutorials covering Xilinx design flows, from design entry to 
verification and debugging

http://www.xilinx.com/support/techsup/tutorials/index.htm

Answer Browser Database of Xilinx solution records

http://www.xilinx.com/xlnx/xil_ans_browser.jsp

Application Notes Descriptions of device-specific design techniques and approaches

http://www.xilinx.com/xlnx/xweb/
xil_publications_index.jsp?category=Application+Notes

http://www.xilinx.com
http://www.xilinx.com/support
http://www.xilinx.com/support/techsup/tutorials/index.htm
http://www.xilinx.com/xlnx/xil_ans_browser.jsp
http://www.xilinx.com/xlnx/xweb/xil_publications_index.jsp?category=Application+Notes
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Conventions
This document uses the following conventions. An example illustrates each convention.

Typographical
The following typographical conventions are used in this document:

Data Sheets Device-specific information on Xilinx device characteristics, 
including readback, boundary scan, configuration, and debugging

http://www.xilinx.com/xlnx/xweb/xil_publications_index.jsp

Documentation 
and Literature

Latest Technical Documentation and Product Literature

http://www.xilinx.com/literature/index.htm

Problem Solvers Interactive tools that allow you to troubleshoot your design issues

http://www.xilinx.com/support/troubleshoot/psolvers.htm

Tech Tips Latest news, design tips, and patch information for the Xilinx 
design environment

http://www.xilinx.com/xlnx/xil_tt_home.jsp

Resource Description/URL

Convention Meaning or Use Example

Courier font
Messages, prompts, and 
program files that the system 
displays

speed grade: - 100

Courier bold
Literal commands that you 
enter in a syntactical statement ngdbuild design_name

Helvetica bold

Commands that you select 
from a menu File → Open

Keyboard shortcuts Ctrl+C

Italic font

Variables in a syntax 
statement for which you must 
supply values

ngdbuild design_name

References to other manuals
See the Development System 
Reference Guide for more 
information.

Emphasis in text
If a wire is drawn so that it 
overlaps the pin of a symbol, 
the two nets are not connected.

Square brackets    [  ]

An optional entry or 
parameter. However, in bus 
specifications, such as 
bus[7:0], they are required.

ngdbuild [option_name] 
design_name

http://www.xilinx.com
http://www.xilinx.com/xlnx/xweb/xil_publications_index.jsp
http://www.xilinx.com/literature/index.htm
http://www.xilinx.com/support/troubleshoot/psolvers.htm
http://www.xilinx.com/xlnx/xil_tt_home.jsp
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Online Document
The following  conventions are used in this document:

Braces    {  } A list of items from which you 
must choose one or more lowpwr ={on|off}

Vertical bar    | Separates items in a list of 
choices lowpwr ={on|off}

Vertical ellipsis
.
.
.

Repetitive material that has 
been omitted

IOB #1: Name = QOUT’ 
IOB #2: Name = CLKIN’
.
.
.

Horizontal ellipsis  . . . Repetitive material that has 
been omitted

allow block  block_name 
loc1 loc2 ... locn;

Convention Meaning or Use Example

Convention Meaning or Use Example

Blue text
Cross-reference link to a 
location in the current 
document

See the section “Additional 
Resources” for details.

Refer to “Title Formats” in 
Chapter 1 for details.

Red text Cross-reference link to a 
location in another document 

See Figure 2-5 in the 
Constraints Guide.

Blue, underlined text Hyperlink to a website (URL) Go to http://www.xilinx.com 
for the latest speed files.

http://www.xilinx.com
http://www.xilinx.com
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Chapter 1

Introduction

This chapter provides details about the contents of the CDs in your software package, 
as well as the operating system, equipment, and system memory requirements needed to 
install and use the software. There is also information about finding software features, 
software documentation, and Xilinx® device architectures supported in this release. 

This chapter contains the following sections:

• “Software CD Contents”

• “New Software Features”

• “System Requirements”

• “Equipment and Permissions”

• “Architecture Support”

• “Software Documentation”

• “License Agreements”

Software CD Contents
This section lists the titles and contents of the CDs in your package.

The Xilinx Integrated Software Environment (ISE) 7.1i CD titles in your software package 
are as follows. Table 1-1 lists the contents of the ISE 7.1i Installation CDs.

Table 1-1: ISE 7.1i Installation CDs

CD Title Description

ISE 7.1i Disc 1 of 3 - 
Windows®/Solaris®/Linux®

Design Environment and Documentation

Contains all the software necessary to 
synthesize, compile, and program FPGA 
and CPLD devices. The software 
components available for installation 
depend on the product configuration that 
you have purchased. Refer to the 
“Product Configurations” section for 
more information. This CD also contains 
the online software documentation. 
There is a separate installation CD for 
each platform.

ISE 7.1i Disc 2 of 3 - 
Windows/Solaris/Linux

Device Files

Contains device files for the following 
devices: CPLD, Spartan™-II/-IIE/-3, and 

Virtex™/-E/-II/-II Pro

http://www.xilinx.com


12 www.xilinx.com ISE 7.1i Release Notes and Installation Guide
P/N 0402346 

Chapter 1: Introduction
R

New Software Features
A list of the new features in this software release is found in the whatsnew.htm file under 
the usenglish directory of the Design Environment CD, or by selecting Start → Xilinx ISE 
7.1i → Documentation → What’s New after the software is installed.

The latest versions of software manuals, which are in PDF format, include information 
about how to use the software features. For more detailed information, see the ISE Quick 
Start Tutorial, which describes these new features. 

System Requirements
This section provides information on supported operating systems, Web browser, cable 
installation, and system memory requirements.

Supported Operating Systems
The following table lists the Xilinx® Integrated Software Environment ISE 7.1i software 
operating systems and versions.

Table 1-2: Supported Operating Systems

ISE 7.1i Disc 3 of 3- 
Windows/Solaris/Linux

Device Files

Contains device files for the following 
devices: Spartan-3E™ and Virtex-4™

ISE 7.1i Standalone Programming Tools- 
Windows/Solaris/Linux 

Standalone Programming Tools for Lab 
Installations

Contains tools and data files necessary to 
program all Xilinx CPLDs and FPGAs. 
May be used as a standalone installation 
to create an environment for the sole 
purpose of programming Xilinx devices. 

Table 1-1: ISE 7.1i Installation CDs

CD Title Description

Platform Type Version Number

Windows® 2000 SP2, SP3, SP4

XP Pro SP1, SP2

Japanese Windows® 2000 SP2, SP3, SP4

XP Pro SP1, SP2

Chinese Windows® 2000 SP2, SP3, SP4

XP Pro SP1

Korean Windows® 2000 SP2, SP3, SP4

XP Pro SP1

Solaris® 8, 9

Linux® Red Hat® Enterprise 3.0 (32 bit 
and 64 bit)

http://www.xilinx.com
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Web Browser 
You must use a web browser to view the online Help and documentation. Your browser 
must be XML-enabled to view reports generated by the CPLD software. The following 
table lists Xilinx supported web browsers.

Table 1-3: Web Browser Support

Cable Installation Requirements
To install cable drivers on Linux, you must have root privileges. To install platform cable 
USB for USB 2.0 port, you must have Win2K SP4 or WinXP SP1. The platform cable USB is 
a high-performance download cable that attaches to user hardware for programming or 
configuring.

System Memory Recommendations
This section gives the RAM and swap space needed to run ISE 7.1i on your system.

While the following table lists the system recommendations for typical designs, the unique 
characteristics of each design affect the system resources required. Design complexity and 
constraints affect whether the design can be implemented using more or less memory. 
Each designer must monitor the system resources and adjust the systems resources, 
if necessary.

Web Browser Versions

Windows® Netscape 4.7 or higher

Internet Explorer 5 or higher

Mozilla 1.4 or higher

Solaris® Netscape 4.7 or higher

Mozilla 1.4 or higher

Linux® Netscape 7.01 or higher

Mozilla 1.4 or higher

http://www.xilinx.com
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The following table lists the memory recommendations for Xilinx® devices.

Table 1-4: Memory Recommendations

Xilinx Device RAM 
Virtual 

Memory

XC9500™/XL/XV 

Automotive 9500XL

CoolRunner™, CoolRunner-II™

Automotive CoolRunner-II

Spartan-II™ XC2S15 through XC2S200 

Spartan-IIE™XC2S50E through XC2S200E 

Automotive Spartan-IIE A2S50E through A2S200E

Spartan-3™ XC3S50 through XC3S200

Automotive Spartan-3 A3S50 through A3S200

Spartan-3E™ XC3S100E through XC3S150E

Virtex™ XCV50 through XCV150 

Virtex-E™ XCV50E through XCV200E

Virtex-II™ XC2V40 through XC2V250 

128 Megabytes 128 MB

Spartan-IIE XC2S300E through XC2S600E

Automotive Spartan-IIE A2S300E 

Spartan-3 XC3S400

Automotive Spartan-3 A3S400 

Spartan-3E XC3S500E

Virtex XCV300 through XCV400 

Virtex-E XCV400E 

Virtex-II XC2V500

Virtex-II PRO XC2VP2

256 MB 256 MB

Spartan-3 XC3S1000

Automotive Spartan-3 A3S1000 

Spartan-3E XC3S1200E

Virtex XCV600 through XCV800 

Virtex-E XCV600E 

Virtex-II XC2V1000

Virtex-II PRO XC2VP4 through XC2VP7

Virtex-4 XC4VLX15 through XC4VLX25

Virtex-4 XC4VFX12 through XC4VFX20

Virtex-4 XC4VSX25

512 MB 512 MB

http://www.xilinx.com
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Note: QPro Hi-Rel and QPro Rad-Hard device memory recommendations are equal to the standard 
device memory recommendations. For example, the memory recommendations for an XC2V3000 
are the same as for an XQR2V3000.

Note: System memory recommendations may be skewed depending on design size.

Enhanced RAM Support for Targeting Large Devices and Complex 
Designs

The MS Windows and Linux® operating system (OS) architectures have limitations on the 
maximum memory available to a Xilinx® program. Users targeting the largest devices and 
most complex designs may encounter this limitation. ISE 7.1i has optimized memory and 
enabled software support for applications to increase RAM memory available to Xilinx 
software. 

Windows XP

Xilinx® applications are enabled to take advantage of this feature. You must also enable 
this feature in Windows XP by modifying your OS. 

Before enabling 3GB support for Xilinx applications, please read Microsoft Knowledge 
Base Article #328269 at http://support.microsoft.com/?kbid=328269. If you upgrade your 
computer to Windows XP Service Pack 1 (SP1) and you are using the /3GB switch, 

Spartan-3 XC3S1500 through XC3S2000

Virtex XCV1000 

Virtex-E XCV1000E through XCV2000E 

Virtex-II XC2V1500 

Virtex-II PRO XC2VP20 through XC2VP40

Virtex-II PRO X XC2VPX20

Virtex-4 XC4VLX40 through XC4VLX60

Virtex-4 XC4VFX40 through XC4VFX60

Virtex-4 XC4VSX35 through XC4VSX55

1 Gigabyte 1 GB

Spartan-3 XC3S4000 through XC3S5000

Virtex-E XCV2600E through XCV3200E 

Virtex-II XC2V2000 through XC2V6000 

Virtex-II PRO XC2VP50 through XC2VP70

Virtex-II PRO X XC2VPX70

Virtex-4 XC4VLX80 through XC4VLX100

Virtex-4 XC4VFX100

2 GB 2 GB

Virtex-II XC2V8000

Virtex-II PRO XC2VP100

Virtex-4 XC4VLX160 through XC4VLX200

Virtex-4 XC4VFX140

3 GB 3 GB

Table 1-4: Memory Recommendations

Xilinx Device RAM 
Virtual 

Memory

http://www.xilinx.com
http://support.microsoft.com/?kbid=328269
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Windows may not restart without a patch from Microsoft. Please see (Xilinx Answer 17905) 
for more information. 

The standard Windows OS architecture limits the maximum memory available to a Xilinx 
program to 2 GB. In Windows XP Professional, Microsoft created an option to support the 
ability of an application to address 3 GB of RAM. Xilinx ISE applications have built-in 
support for this option. To take advantage of this capability, you must also modify your 
Windows XP OS to enable this feature, which requires that you modify your "boot.ini" file 
by adding a "/3GB" entry to the end of the "startup" line.

Before making this change, please read: 

• Microsoft Bulletin Q17193 http://support.microsoft.com/default.aspx?scid=kb;en-
us;Q171793, which contains information on "Application Use of 4GT RAM Tuning".

• Microsoft Bulletin Q289022 http://support.microsoft.com/default.aspx?scid=kb;en-
us;q289022, contains instructions for editing your "boot.ini" file. 

Linux

ISE 7.1i now supports Lin64 which allows greater memory allocation. Xilinx has 
documented Linux kernel modifications that allow a Xilinx application to address over 3 
GB of memory. 

Solution 1:

Red Hat Enterprise Edition WS 3.0 can utilize the hugemem kernel to allocate 4GB to each 
process. More information can be found on the Red Hat support site: 
http://www.redhat.com/docs/manuals/enterprise/RHEL-3-Manual/release-notes/ws-
x86/ 

Solution 2:

A kernel rebuild can be attempted for Red Hat numbered releases: The following steps 
apply only to the specific kernel mentioned (2.4.7). 

Background of System Parameters: 

• The system parameter TASK_SIZE is the basic limit on the per-process address space 
available in user mode. 

• TASK_SIZE is defined to be the same as PAGE_OFFSET in "include/asm-
i386/processor.h". 

• PAGE_OFFSET depends on __PAGE_OFFSET, which depends on 
PAGE_OFFSET_RAW in "include/asm-i386/page.h". 

• PAGE_OFFSET_RAW is defined in "include/asm-i386/page_offset.h" according to 
the definitions of CONFIG_1GB, CONFIG_2GB, or CONFIG_3GB from 
"linux/config.h". 

Steps for A Kernel Rebuild: 

The kernel can be compiled from the existing source tree in "/usr/src/linux-2.4.7-10". 
Please refer to the Linux support documentation for any questions. The steps required to 
rebuild the kernel are: 

1. Unpack the sources if necessary, and cd to the sources directory. 

2. Edit "include/asm/page_offset.h" header to modify PAGE_OFFSET_RAW to the new 
value of 0xF0000000 (3.75GB). 

http://support.microsoft.com/default.aspx?scid=kb;en-us;q289022
http://support.microsoft.com/default.aspx?scid=kb;en-us;q289022
http://www.xilinx.com
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q171793
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q171793
http://www.redhat.com/docs/manuals/enterprise/RHEL-3-Manual/release-notes/ws-x86/
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3. Run "make clean". (Start with a clean slate.) 

4. Run "make mrproper". (This does more clean up, inside modules too.) 

5. Run "make oldconfig". (This picks up the old configuration for i686 smp architecture.)

6. Run "make dep". 

7. Run "make bzImage". (This makes the kernel in "arch/i386/boot".) 

8. Run make modules. (This makes all kernel modules.) 

9. Run "make modules_install". (This installs the modules in "/lib/modules/2.4.7-
10custom".) 

10. Copy the bzImage from "arch/i386/boot" to "/boot". 

11. Configure GRUB to boot from "/boot" area kernel from Hard Disk. 

12. Optionally, you can also create a bootable floppy using "make bzdisk". (This creates a 
boot floppy disk.) 

Problems/Solutions: 

1. "linux/compile.h" not found. 
Touch the "include/linux/vesion.h" file as "linux/compile.h" (which is generated at 
run time). 

2. "/lib/modules/2.4.7-10custom/modules.dep" not found. 
Perform a "modules_install", as the kernel needs this file while booting to look for 
modules dependency. 

3. ypbind is not able to bind to NIS Domain. 
This happens when you compile only the kernel and not modules. You must compile 
and install modules along with the core kernel. 

4. Mount points do not work. 
Because of the way in which mount points are set on Linux machines, they will not 
work with the new kernel as the name of the kernel is now changed to 2.4.7-10custom, 
and automounter looks for 2.4.7-10Linux. You must add links on the ypserver to make 
the automounts work. 

Equipment and Permissions
The following table lists related equipment, permissions, and network connections.

Table 1-5: Equipment and Permissions Requirements

Item Requirement

Directory permissions Write permissions must exist for all directories containing 
design files to be edited. 

Monitor Color VGA with a minimum recommended resolution of 
1024 by 768 pixels. 

CD Drive You must have an ISO9660-compliant drive on your system.

http://www.xilinx.com
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Note: Emulators such as Exceed, ReflectionX, and XWin32 are not supported.

Network Time Synchronization
When design files are located on a network machine, other than the machine with the 
installed software, the clock settings of both machines must be set the same. These times 
must be synchronized on a regular basis for continued proper functioning of the software.

Architecture Support
The ISE 7.1i software supports the following architecture families:

• Virtex™/-E/-II/-II Pro/-II Pro X/-4

• QPro Virtex™/-E/-II Hi-Rel 

• QPro Virtex™/-II Rad-Hard 

• Spartan™ -II/-IIE/-3/-3E

• Automotive Spartan-IIE/-3

• XC9500™/XL/XV

• Automotive 9500XL

• CoolRunner™ XPLA3/-II

• Automotive CoolRunner-II

Product Configurations
Following is a list of the product configurations for this release:

• ISE Foundation

• ISE BaseX

• ISE WebPACK

Note: ISE WebPACK is a free software configuration available on this CD or for download at 
http://www.xilinx.com/ise/webpack.

Ports To program devices, you must have an available serial, 
parallel, or USB port appropriate for your Xilinx 
programming cable. Specifications for ports are listed in the 
documentation for your cable.

Note: To use the new Platform Cable USB, you must have a 
Win2K SP4 or WinXP SP1 supported operating system.

Networks The Xilinx installation program supports Microsoft, Sun, 
and Red Hat networks with TCP/IP. Novell Netware 
TCP/IP is not supported.

Item Requirement

http://www.xilinx.com/ise/webpack
http://www.xilinx.com
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The following table lists the contents of each product configuration.

The following table lists the contents of each product configuration.

Table 1-6: Product Configurations 

Feature
ISE WebPACK

(MS Windows & Linux)
ISE BaseX 

(MS Windows & Linux)

ISE Foundation
(MS WINDOWS,
Linux & Solaris)

Schematic Editor Yes Yes Yes

State Diagram Entry Yes MS Windows Only MS Windows Only

XST Synthesis Yes Yes Yes

Synplify/Synplify Pro
Integration

Yes Yes Yes

Leonardo Spectrum 
Integration

Yes Yes Yes

Precision Integration Yes Yes Yes

Waveform Editor MS Windows Only MS Windows Only MS Windows Only

ISE Simulator No

MS Windows only 
Limited version included

MS Windows only
Limited version included

Unlimited version 
available as option

Modelsim Xilinx 
Edition

MS Windows only
Starter included Full MXE 
available as option

MS Windows only 
Starter included Full MXE 
available as option

MS Windows only Starter 
included Full MXE 
available as option

Modelsim Integration Yes Yes Yes

CORE Generator No Yes Yes

Floorplanner Yes Yes Yes

FPGA Editor No Yes Yes

Device Programming 
Support

Yes Yes Yes

Table 1-7: Device Configurations 

Family ISE WebPack
(MS Windows & Linux)

ISE BaseX
(MS Windows & Linux)

ISE Foundation 
(MS Windows, Linux & 

Solaris)

Virtex devices No Up to V600 All

Virtex-E devices Up to V300E Up to V600E All

Virtex-II devices Up to 2V250 Up to 2V500 All

Virtex-II Pro devices 2VP2 Up to 2VP7 All

http://www.xilinx.com


20 www.xilinx.com ISE 7.1i Release Notes and Installation Guide
P/N 0402346 

Chapter 1: Introduction
R

Software Documentation
The following sections provide answers to your questions about using the Xilinx® ISE 
software documentation and help tools. 

Software Manuals and Help Online
ISE Software manuals are provided on ISE 7.1i, Disc 1 of 3, as well as on the Web. 
For documentation, refer to the Software Manuals web collection at the following URL: 
http://www.xilinx.com/support/software_manuals.htm.

Virtex-II Pro X devices No No All

Virtex-4 devices 4VLX15, 4VLX25 4VLX15, 4VLX25, 
4VSX25, 4VFX12

All

QPro Virtex Hi-Rel devices No Up to QV600 All

QPro VirtexE Hi-Rel devices No Up to QV600E All

QPro Virtex2 Hi-Rel devices No No All

QPro Virtex Rad-Hard 
devices

No Up to QVR600 All

QPro Virtex2 Rad-Hard 
devices

No No All

Spartan-II devices All All All

Spartan-IIE devices Up to 2S300E All All

Automotive Spartan-IIE 
devices

All All All

Spartan-3 devices Up to 3S1500 Up to 3S1500 All

Automotive Spartan-3 
devices

All All All

Spartan-3E devices Up to 3S500E All All

XC9500/XL/XV devices All All All

Automotive 9500XL devices All All All

CoolRunner/II devices All All All

Automotive CoolRunner-II 
devices

All All All

Device Programming 
Support

All All All

Table 1-7: Device Configurations 

Family ISE WebPack
(MS Windows & Linux)

ISE BaseX
(MS Windows & Linux)

ISE Foundation 
(MS Windows, Linux & 

Solaris)

http://www.xilinx.com
http://support.xilinx.com/support/library.htm
http://support.xilinx.com/support/software_manuals.htm
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Context-sensitive online help is available for most Xilinx® programs that are available with 
a graphical user interface (GUI). From Project Navigator, select Help → ISE Help 
Contents to access the online help. HTML Help is now available from the software 
manuals area on the web. To access the Help collection on the Web refer to 
http://www.xilinx.com/support/sw_manuals/xilinx7/index.htm.

The updated Constraints Guide now includes Virtex-4 constraints. 

Note: The Constraints Guide is only available from the Software Manuals collection on the Web.

Xilinx Support Website Resources
The Xilinx MySupport Website, http://www.xilinx.com/support, provides additional 
help resources such as Application Notes, Data Sheets, Tutorials, Problem Solvers, Tech 
Tips, and Answer Records.

License Agreements
Xilinx supports the following licensing agreements.

PERL License Agreement
XILPERL is a modified version of PERL licensed to Xilinx® and to you under the Artistic 
license. The text of the artistic license may be seen at: 
http://www.perl.com/language/misc/Artistic.html 

XILPERL is invoked implicitly by ISE applications when it is needed and there is no need 
for the user to invoke it directly. The only difference between XILPERL and unmodified 
PERL is that XILPERL picks up its input script file from the location specified in the Xilinx 
environment variable, and not from STDIN. 

XILPERL is not packaged in ISE to be used as a standalone PERL by the end user. The 
unmodified version of PERL may be obtained in source or executable form from 
http://www.perl.com. 

Regex++ Licensing Terms
Regex++, Index.

(Version 3.20, 29th Sept 2001)  

Copyright (c) 1998-2001 

Dr. John Maddock

Permission to use, copy, modify, distribute and sell this software and its documentation for 
any purpose is hereby granted without fee, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this permission notice appear 
in supporting documentation. Dr. John Maddock makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied 
warranty.

Acknowledgement
Some of the features in the Xilinx software tools were implemented using ANTLR, 
a language recognition tool. See http://www.ANTLR.org.
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Chapter 2

Installation Instructions

This document describes how to install the Xilinx® software tools, online documentation, 
and ModelSim Xilinx Edition II, as well as how to set up the system environment. This 
chapter comprises the following sections:

• “Installing Xilinx ISE Software”

• “Running Multiple Versions of Xilinx Software”

• “Platform Specific Instructions”

• “Installing ModelSim Xilinx Edition III Software (MS Windows Only) - Optional”

• “Installing Standalone Programming Tools (Lab Environment)”

• “Network Installations”

• “Installing Documentation”

• “Obtaining Software Updates”

• “Troubleshooting with Xinfo”

• “Using Other Versions of ModelSim”

• “Uninstalling ISE Software”

Installing Xilinx ISE Software
ISE 7.1i has a multi-CD installation system. For a first-time installation, the operating 
system specific CD and at least one device CD must be installed to have a complete 
installation of programs and selected FPGA or CPLD devices

This section explains the ISE 7.1i installation process for all platforms. Platform-specific 
details of the installation procedure follow these steps:

1. Close all programs before you begin installation.

2. Locate the Product ID number located on a sticker on the software package from 
Xilinx.

3. Ensure that your system meets the requirements described in the “Introduction” 
chapter.

4. Check the “Known Issues” chapter and Xilinx Hotsheet for any installation issues that 
pertain to your system or configuration.

5. Insert the ISE 7.1i Disc 1 of 3.

6. Run the setup program and follow the instructions on the screen to install the software.

7. If not already done by the installer, manually set your XILINX Environment Variable 
before installing Disc 2. See Platform Specific Instructions for more information.

8. Insert ISE 7.1i Disc 2 of 3 and run the installation program for Disc 2.

http://www.xilinx.com
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9. If not already done by the installer, manually set your XILINX Environment Variable 
before using the ISE 7.1i software. See Platform Specific Instructions for more 
information.

Installing Adobe Acrobat Reader+Search
You must have Adobe Acrobat Reader installed to view and search the PDF manuals. 
If you do not have Acrobat Reader, you can install version 6 from the usenglish 
subdirectory on ISE 7.1i Disc 1 of 3.

To ensure that you can view and search the Software Manuals, upgrade to Adobe Acrobat 
Reader+Search as follows: 

MS Windows:

1. Go to the root directory of the CD.

2. Go to the usenglish\acrobat\pc directory.

3. Double-click the executable file.

Solaris:

1. Go to the root directory of the CD.

2. Go to the usenglish/acrobat/sol directory.

3. Copy the file in this directory to a local directory.

4. Go to the local directory.

5. Unzip the file and then extract the contents of the tar file.

6. Run the INSTALL script.

LINUX:

1. Go to the root directory of the CD.

2. Go to the usenglish/acrobat/lin directory.

3. Copy the file in this directory to a local directory.

4. Go to the local directory.

5. Unzip the file and then extract the contents of the tar file.

6. Run the INSTALL script.

Note: The Acrobat Reader+Search functionality is available on Windows and Macintosh.

http://www.xilinx.com
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Running Multiple Versions of Xilinx Software
To maintain multiple versions of software, read the following document for information 
about which configurations are supported, about setting up your user environment, and 
about switching among software versions:

http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=8915

The ISE 7.1i installer does not allow you to install to a directory that contains an older 
version of Xilinx® software. You must either uninstall the older version, or install ISE 7.1i 
to a different location. If you attempt to install ISE 7.1i over ISE 6.3i, the installer gives you 
the option of automatically uninstalling older versions of the Xilinx software before 
continuing. 

Note: To retain your ISE installation and also install ISE 7.1i, select the option to install in a different 
directory. 

Note: Before uninstalling, be sure you have moved any project files you want to keep outside your 
Xilinx installation directory structure, or it will be deleted. 

See the uninstall information later in this chapter for issues when running multiple 
installations.

Platform Specific Instructions
This section explains the platform-specific details of the ISE 7.1i installation. 

MS Windows 
This section describes how to start installation and set environment variables.

To Start Installation 

The installer automatically starts when the CD is inserted. If it does not, from Windows 
select Start → Run. Type D:\setup.exe where D:\ is the CD drive.

To Set Environment Variables

The installer provides an option to have these variables set automatically to the 
appropriate values. The variables are set by default to:

PATH=%XILINX%\bin\nt;%PATH%

To verify or change your Windows environment variables, see 

http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=11630

Solaris
This section describes how to start installation and set environment variables.

To Start Installation 

Click the setup file in your file manager, or at the Solaris prompt, type cd 
/cdrom/cdrom0. Then type ./setup.

To eject cdrom, cd out of the directory /cdrom/cdrom0 or /mnt/cdrom and then type 
eject cdrom.

http://www.xilinx.com
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=11630
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=8915
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To Set Environment Variables

At the completion of the installation process, the installation program creates an 
environment variables file for you. Go to your XILINX installation directory and type 
source settings.csh or source settings.sh as appropriate to your shell.

To set your environment variables manually or from within your own setup script, copy 
the settings in the settings.sh (or settings.csh) file. Xilinx® environment variables 
settings are specific to each OS platform.

Linux 
This section describes how to start installation and set environment variables.

To Start Installation 

Click the setup file in your file manager or at the Solaris prompt, type cd /mnt/cdrom. 
Then type ./setup. 

Note: Mozilla browser users may need a JRE plug-in to access the Xilinx download pages. 

To Set Environment Variables

At the completion of the installation process, the installation program creates an 
environment variables file for you. Go to your XILINX installation directory and type 
source settings.csh or source settings.sh appropriate to your shell.

To set your environment variables manually or from within your own setup script, it is 
recommended that you copy the settings in the settings.sh (or settings.csh) file. 
Xilinx environment variables settings are specific to each OS platform.

Registration
To complete your software installation, you must register your software with Xilinx. Use 
the links provided on the Welcome screen of the installer to register by Web, e-mail, or fax. 
You will need the Product ID number located on a sticker on the software package from 
Xilinx. After completing the registration process, a Registration ID and any necessary 
license files will be sent to you. Return to the installation program to continue with the 
software installation.

Installation of ISE Programs and Devices
ISE 7.1i has a multi-CD installation system. For a first-time installation, the operating 
system specific CD and at least one device CD must be installed to have a complete 
installation of programs and selected FPGA or CPLD devices

http://www.xilinx.com
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Selecting Xilinx Modules

The following figure shows the screen from Installation Disc 1 of 3 to select which Xilinx® 
modules you wish to install.

Adding Programs 

After a complete installation using ISE 7.1i Disc 1 of 3 and 7.1i Disc 2 of 3, add devices by 
re-running ISE 7.1i Disc 2 of 3 only. The Software Install includes the software 
documentation.

Figure 2-1: ISE 7.1i Disc 1 of 3 - Select Xilinx Modules Screen

http://www.xilinx.com
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Figure 2-2 shows the screen from Installation Disc 2 of 3 to select which Xilinx® Modules 
you wish to install.

Figure 2-2: ISE 7.1i Disc 2 of 3 - Select Xilinx Modules Screen

http://www.xilinx.com
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Selecting Device Families

Figure 2-3 shows the screen from Installation Disc 2 of 3 to select the Device Families that 
you wish to install.

Installing ModelSim Xilinx Edition III Software 
(MS Windows Only) - Optional

If you have already purchased MXE, you will receive a license file after registering the 
MXE software after installation. For complete product and purchasing information for 
MXE, contact your local Xilinx representative or visit the following Xilinx website:

http://www.xilinx.com/xlnx/xil_prodcat_product.jsp?title=modelsim_xe

To install MXE software, perform the following steps:

1. Insert the ModelSim Xilinx Edition CD. 

2. If the CD does not auto run, select Start → Run → D:\setup.exe.

3. Follow the instructions to complete the installation.

4. Follow the instructions provided to complete a license request. A license file will be 
e-mailed to you.

5. Put the license in a location pointed to by the LM_LICENSE_FILE variable as follows:

set LM_LICENSE_FILE=<path_to_license>\license.dat

You can also cut and paste the contents into your existing license.dat file.

Note: For versions of ModelSim, other than MXE III, see “Using Other Versions of ModelSim” later 
in this chapter.

Note: For more information on MXE use, installation, and licensing, see the Modelsim Xilinx Edition 
Tech Tip found on the main Tech Tips page here: http://www.xilinx.com/xlnx/xil_tt_home.jsp.

Figure 2-3: ISE 7.1i Disc 3 of 3 - Select Xilinx Device Families Screen

http://www.xilinx.com/xlnx/xil_prodcat_product.jsp?title=modelsim_xe
http://www.xilinx.com
http://support.xilinx.com/xlnx/xil_tt_home.jsp
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Installing Standalone Programming Tools
(Lab Environment)

ISE 7.1i allows you to install a subset of the software just for programming all Xilinx® 
devices and formatting programming files. This option allows users to set up a PC in a 
bench-top or "lab" environment for programming devices without having to install the full 
version of the software. 

To install, run the installation on the ISE 7.1i Standalone Programming Tools disk.

Network Installations
Installing software to a network location provides a way for various client machines to 
access the software by pointing to it on the network drive. To run the software on the 
network, the client machines must be set up correctly to ensure that the environment 
variables, registry, and program groups all point to the network. The following sections 
describe the procedure for network setups.

Workstation Clients
1. Each software user must source the settings.csh or settings.sh from the 

$XILINX area where the software is installed. This points the Xilinx environment 
variable, path and LD_LIBRARY_PATH to the installed location.

2. To run the software applications from a remotely installed location, you must also run 
an X Windows display manager, and you must include a DISPLAY environment 
variable. Define DISPLAY as the name of your display. DISPLAY is typically unix:0.0. 
For example, the following syntax allows you to run the software on the host named 
bigben and to display the graphics on the local monitor of the machine called 
mynode:

setenv DISPLAY mynode:0.0
xhost = bigbenPC Clients

http://www.xilinx.com
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PC Clients
1. Install the ISE software tools to a PC network server. Make sure that your users know 

the location of the software tools and have access to the installation directory, and that 
they have Administrator privileges for the following steps.

2. From the local client machine, browse to the following directory: 
network_install_location/bin/nt and run the program setXenv.bat.

Running this program sets up the environment and registry settings needed to run the 
Xilinx® tools from the remote location. 

3. Map a network drive, at \\name_of_your_server\xilinx 

To verify that the network drive is mapped correctly (for instance, if you call it F:), type 
"F:" in a dos command, and you will be in your Xilinx server folder.

4. Run setXenv.bat, in F:\bin\nt.

Note: Network Administrators, in addition read the WebUpdate section for use on network 
installations. 

Installing to a Mounted Network Drive
When installing to a mounted network drive without a subdirectory for Xilinx software. 
Xilinx software is designed to be installed in a directory under ROOT (typically C: \Xilinx). 
The installer presents this option normally when installing to a local driver, but when 
installing to a mounted network drive, a subdirectory might not be defined and it appears 
to the Installer as if it is installing to a ROOT directory.

To work around this issue, define your target installation directory as "\Xilinx" under the 
network mount point (For example: "N:\Xilinx"). For more information see, 
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=18847.

Installing Documentation
The ISE 7.1i Software Install includes installing the documentation. You must install Adobe 
Acrobat Reader to view the installed documentation.

Software Manuals Installation
The Xilinx ISE documentation is automatically installed as part of the software installation. 
After you install the software, you can select the Help → Online Documentation 
command from your software tools to access the Software Manuals collection.

For added convenience, Xilinx Software Manuals are also on the Web. See, 
http://www.xilinx.com/support, and click the "Software Manuals" button in the left 
navigation bar.

Note: The documentation is not installed as part of ISE WebPACK installations.

Obtaining Software Updates
The following sections describe the ways to obtain software updates.

http://www.xilinx.com/support
http://www.xilinx.com
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=18847
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=18847
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Traditional Service Packs
Service Packs and other Software Updates for all platforms are regularly made available on 
the Software Updates Page at: http://www.xilinx.com/xlnx/xil_sw_updates_home.jsp.

WebUpdate for PC Platforms
WebUpdate is a new tool that provides an alternative method of obtaining software 
updates on the PC. It provides the following features: 

• Compares the latest version of software updates available on 
www.xilinx.com/support with the version of ISE that you have installed and notifies 
you if a newer version is available. 

• Downloads and installs the update in one step. 

• Downloads only the files necessary to update your installation. 

WebUpdate can be run in any of the following ways: 

• Automatic periodic checks at Project Navigator startup time. 

• Help → Software Updates from Project Navigator. 

• Accessories → WebUpdate from the Xilinx® ISE Program Group. 

WebUpdate provides the ability to check for and install Service Pack updates, as well as 
CPLD supplemental updates. When a new update is found, a similar dialog to the 
following figure appears. 

Figure 2-4: WebUpdate Dialog Box

http://www.xilinx.com
http://www.xilinx.com/xlnx/xil_sw_updates_home.jsp
support.xilinx.com
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The Details button provides more information on the specific enhancements that are 
included in the update.

The Edit → Preferences menu selection in Project Navigator allows you to control the 
frequency of the automatic checks that happen at Project Navigator startup time. 

Note: The Lab Install does not have automatic notification of updates through WebUpdate. You 
must update with Service Packs available at http://www.xilinx.com/xlnx/xil_sw_updates_home.jsp.

You can also launch WebUpdate anytime from within Project Navigator at Help → 
Software Updates, or from the Xilinx ISE 7.1i Program Menu at Start → Xilinx ISE 7.1i → 
Accessories.

WebUpdate Network Installations

By default, the WebUpdate automatic checks at Project Navigator startup are enabled on 
the machine used to install the ISE software to the network location. All clients pointing to 
this network location will have WebUpdate automatic checks disabled by default. Client 
users have the option of enabling automatic checks (Edit → Preferences → Updates from 
Project Navigator) and also running manual checks. 

Note: To perform a software update installation, you must have write permissions on the $XILINX 
installation directory. 

Note: The mapped drive to the full installation is the root of the drive mounted from the client PC. 
Therefore, when setxenv.bat runs the $XILINX on the client machine is set to the root of the drive. For 
example, K:\ The Xilinx tools don’t like the $XILINX being set to the root of a drive.

Troubleshooting with Xinfo
Xinfo provides assistance in troubleshooting your installation. The Xinfo tool analyzes 
your Xilinx® software installation and hardware environment. Before contacting Technical 

Figure 2-5: Updates Tab (Preferences Dialog Box)

http://www.xilinx.com
http://support.xilinx.com/xlnx/xil_sw_updates_home.jsp
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Support, run xinfo to view your system information and then export the results as 
follows:

PC
1. Select Start → Programs → Xilinx ISE 7.1i → Accessories → Xinfo System 

Checker.

2. Select File → Export to save your report as a text file.

3. If your system does not correctly display the Xinfo GUI, you can run it from the 
command line and generate an output file by selecting Start → Run → cmd to open a 
command window, then execute xinfo [output_summary_file] to save the 
report to a text file.

4. If necessary, you can also run xinfo from the root directory of ISE 7.1i Disc 1 of 3. 

Solaris and Linux
1. Set your Xilinx environment variables.

2. Run xinfo from the command line.

3. If your system is not correctly displaying the GUI for Xinfo, you can run it from the 
command line and generate an output file by executing Xinfo 
[output_summary_file] to save the report to a text file.

4. If necessary, you can also run xinfo from the root directory of ISE 7.1i Disc 1 of 3.

Using Other Versions of ModelSim
You can integrate non-Xilinx® editions of ModelSim® with ISE as follows:

1. Within the Project Navigator, select Edit → Preferences → Integrated Tools 
heirarchical navigation menu.

http://www.xilinx.com
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The Preferences dialog box appears.

2. Enter the full path name to the directory containing the desired executable for each of 
your tools, or browse to the location of the desired executable (that is, modelsim.exe 
for the Modeltech Simulator).

Note: To change the ModelSim® path setting in the Preference dialog, your profile must be 
configured as a Power User or Administrator for Windows 2000 or Windows XP.

Note: ModelSim is not supported on Linux®.

Uninstalling ISE Software
To uninstall the Xilinx ISE 7.1i software, go to the Xilinx ISE 7.1i uninstall entry in the 
Add/Remove programs dialog.

Before uninstalling, be sure you have moved any project files you want to keep outside 
your Xilinx installation directory structure, or it will be deleted.

Figure 2-6: Preferences Dialog Box

http://www.xilinx.com
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Chapter 3

Known Issues

This chapter lists and describes the most critical known issues in the ISE 7.1i release at 
press time. 

The following sections are in this chapter:

• “Finding All Known Issues”

• “Searching for Answer Records”

• “CORE Generator”

• “CPLD Implementation”

• “Incremental Design”

• “IP Cores”

• “Linux”

• “MAP”

• “Message Filtering”

• “PAR”

• “Partial Reconfiguration”

• “Project Navigator”

• “RocketIO Wizard”

• “Simulation”

• “Speedprint”

• “Wind/U (Solaris and Linux)”

• “XPower”

• “XST”

http://www.xilinx.com
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Finding All Known Issues
The following table lists documents and websites to help you locate answers to your 
questions concerning any known issues.

Searching for Answer Records
Each known issue references an Answer Record number, as well as the applicable URL at 
http://www.xilinx.com/support. If you are viewing this document electronically, click the 
URL link to go to the Answer Record through your Web Browser. For users viewing a 
printed version of this document, the easiest method is to launch your Web Browser to the 
main support page, http://www.xilinx.com/support, and enter the Answer Record 
number in the Search field.

CORE Generator
The following issue pertains to CORE Generator:

Title: ISE 7.1i CORE Generator - Known Issues for CORE Generator in the ISE 7.1i 
software release.

Description: This Answer Record contains a list of known issues for ISE 7.1i CORE 
Generator as well as links to related answer records regarding IP core known issues

Reference: Xilinx Answer Record #20491, or 
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20491

CPLD Implementation
The following issues pertain to CPLD implementation:

1. Title: ISE 7.1i CPLD TA Engine - Timing Analysis does not check the duty cycle portion 
of the PERIOD constraint.

Description: The CPLD Timing Analyzer does not check the duty cycle portion of a 
period constraint.

Table 3-1: Known Issues Document and Websites

Resource Description

READ ME FIRST Hot Sheet 
and Welcome Letter

Introduction to the Release Notes and Installation Guide. 
Printed document included in the software package.

Technical Support Website Complete listing of all known issues at

http://www.xilinx.com/support

Answers Database Listing of Answer Records for the Xilinx® software tools. 

Search this database using the search function at

http://www.xilinx.com/support/searchtd.htm

Technical Tips Latest news, design tips, and patch information for the 
Xilinx design environment at 

http://www.xilinx.com/xlnx/xil_tt_home.jsp

http://www.xilinx.com/xlnx/xil_tt_home.jsp
http://www.xilinx.com/support/searchtd.htm
http://support.xilinx.com/support/searchtd.htm
http://www.xilinx.com/support
http://www.xilinx.com/support
http://www.xilinx.com
http://www.xilinx.com/support
http://www.xilinx.com/support
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20491
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Reference: Xilinx Answer Record #16861, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=16861

2. Title: ISE 7.1i CPLD TA Engine - Performance information for timing constraints does 
not appear displayed in the detailed static timing analysis report.

Description: Timing constraints are listed as "Met" or "Not Met" in the Summary 
report, but they are not mentioned in the Detail Timing report.

Reference: Xilinx Answer Record #17506, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17506

3. Title: ISE 7.1i CPLD CPLDFit - Period timing constraint fails to analyze register-to- 
clock enable path.

Description: A period timing constraint does not cover the path from a register to a 
downstream register’s clock enable.

Reference: Xilinx Answer Record #19546, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=19546

Incremental Design
The following issue pertains to Incremental Design:

Title: ISE 7.1i Incremental Design - All of my Area Groups are reimplemented when 
using ISE 6 guide files.

Description: Guide Files generated in ISE 6.x cause most or all Area Groups to be 
reimplemented if they are used in ISE 7.1i. It is recommended that Incremental Design 
users regenerate all guide files using the ISE 7.1i software to increase quality of results.

Reference: Xilinx Answer Record #20493, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20493

IP Cores
The following issue pertains to IP Cores:

Title: ISE 7.1i - Known Issues for all IP Cores (DSP, System Logic, Networking, System 
I/O).

Description: For compatibility of various IP cores with respect to ISE 7.1i software, see 
Xilinx Answer Record 20486.

Reference: Xilinx Answer Record #20486, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20486

Linux
The following issue pertains to Linux:

Title: Some ISE applications may not work with older versions of Red Hat Linux.

Description: Redhat Enterprise 3 is the only officially supported version of Redhat for 
ISE 7.1i. Older versions, like 9.0, 8.0, and 7.x are no longer officially supported.

http://www.xilinx.com
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=16861
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17506
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=19546
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20493
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20486
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Some applications, like Constraint Editor and Coregen, are known to require updated 
libraries from RedHat in order to run. They may fail with "Error while loading shared 
library: LibXrandr.so.2: can not open shared object file". 

For more information on this issue, please see Answer Record #20607. 

Reference: Xilinx Answer Record #20607, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20607

MAP
The following issues pertain to MAP:

1. Title: ISE 7.1i MAP - Timing-driven packing supports the use of cost tables and extra 
effort modes in ISE 7.1i.

Description: Timing-driven packing makes use of the placement algorithms during 
packing. Some of the options when running PAR placement in the past are now 
available to MAP.

Reference: Xilinx Answer Record #20498, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20498

2. Title: ISE 7.1i MAP - Timing-driven packing duplicates registers, if allowed.

Description: ISE 7.1i version has a new feature that allows for register duplication 
during Timing-driven packing to improve timing. This feature is not enabled by 
default.

Reference: Xilinx Answer Record #20497, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20497

Message Filtering
The following issue pertains to Message Filtering:

Title: ISE 7.1i Message Filtering - Not all Xilinx applications are supported by Message 
Filtering.

Description: Not all Xilinx applications are supported by Message Filtering. For an up-
to-date list of supported and unsupported applications, please see Xilinx Answer 
13142.

Reference: Xilinx Answer Record #13142, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=13142

PAR
The following issues pertain to PAR:

1. Title: ISE 7.1i PAR - Can my old 6.xi NCD file be used now that I have upgraded to 7.1i?

Description: Can my old 6.xi NCD file be used now that I have upgraded to ISE 7.1i? 
Yes. When an NCD from version 6.xi is used in the ISE 7.1i tools, it is converted 
automatically to an ISE 7.1i NCD. Before this occurs, the original NCD is copied to a 
new name and an INFO message is printed.

Reference: Xilinx Answer Record #20495, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20495

http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20497
http://www.xilinx.com
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20498
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=13142
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20495
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2. Title: ISE 7.1i Virtex-4 PAR- The router has a new check to detect unroutable 
configurations.

Description: In the past, the router has been good at detecting when a design is 
unroutable due to congestion and quitting early. What was not handled well was the 
condition where a design was not congested, but due to an unroutable configuration, 
one or more signals could not be successfully routed. The router would tend to waste 
time trying to successfully route an unroutable design. In ISE 7.1i, a new check has 
been added to detect unroutable nets, report the routing conflict and quit before 
wasting any more time on the design.

Reference: Xilinx Answer Record #20499, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20499

Partial Reconfiguration
The following issue pertains to Partial Reconfiguration:

Title: ISE 7.1i Partial Reconfiguration - Partial Reconfiguration support requires an ISE 
7.1i Service Pack.

Description: Software support for Partial Reconfiguration is not enabled by default in 
the ISE 7.1i release. Software support for partial reconfiguration is planned for an ISE 
7.1i Service Pack. For more information, please see Answer Record 20494.

Reference: Xilinx Answer Record #20494, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20494

Project Navigator
The following issues pertain to Project Navigator:

1. Title: ISE 7.1i Project Navigator: Drag & Drop of Language Templates does not work 
correctly on Solaris platform.

Description: To use a Language Template, a user must either ‘copy and paste’ or click 
the ‘Use in File’ icon in the top left corner of the Language Template window.

Reference: Xilinx Answer Record #12069, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=12069

2. Title: ISE 7.1i Project Navigator: Copying a project with open HDL file may cause 
version control issue.

Description: When an HDL file is open in the Project Navigator HDL Editor and the 
project is saved to a new location (File → Save Project as…) The old file remains open. 
Edits to the open HDL file are made to the HDL file in the original directory and not to 
the new HDL file created during the Save Project as operation.

Reference: Xilinx Answer Record #11748, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=11748

3. Title: ISE 7.1i Project Navigator: Remote sources may not be found when a project is 
moved from a PC to a UNIX platform. 

Description: If a project contains remote sources (sources located in a directory other 
than the current project directory) and was created and last saved on a PC, Project 
Navigator has an incorrect path structure for the sources when it is attempted to be 
opened on UNIX. The user should re-add the sources to the project on the UNIX 
platform.

http://www.xilinx.com
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Reference: Xilinx Answer Record #12075, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=12075

4. Title: ISE 7.1i Project Navigator: File → Open requests are sent to the user’s HTML 
browser when HTML report is open. 

Description: If Project Navigator has an open, selected HTML report, such as a CPLD 
fitter report, the File → Open option tries to open any selected file in the HTML 
browser, instead of the preferred text editor.

Reference: Xilinx Answer Record #17495, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17495

5. Title: ISE 7.1i Project Navigator: CPLD fitter reports require Mozilla directory to point 
to the JRE on Linux platform.

Description: To read the HTML format version of a CPLD fitter report on a Linux 
platform, for Mozilla browser version 1.0.1 and Netscape7 browsers the mozilla 
directory must to point to the JRE.

Reference: Xilinx Answer Record #17498, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17498

6. Title: ISE 7.1i - ERROR:16 - <file_name>.vhd Line <##>. Circular hierarchy reference 
found. Breaking cycle at module 'or_tree'.

Description: The Project Navigator HDL parser flags an error on recursively called 
VHDL source files. However, the design may still be correctly synthesized.

Reference: Xilinx Answer Record #20480, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20480

7. Title: ISE 7.1i - Error Navigation finds the correct file but does not navigate to the 
correct HDL line number. 

Description: The Error Navigation link from an error message in the console window 
opens the correct file but, does not indicate the line where the error is supposed to be. 

Reference: Xilinx Answer Record #20580, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20580 

The following issue pertains to Project Navigator w/CORE Generator:

Title: ISE 7.1i - The Refresh button does not update the Language Templates window 
with templates for newly created cores.

Description: If the Language Templates window is open when a CORE Generator 
modules is added to a project, the Language Template window will not update, and 
the new modules are not visible under COREGen/<HDL language>Component 
Instantiation.

Reference: Xilinx Answer Record #9186, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=9186

The following issue pertains to Project Navigator w/ 3rd Party Tools:

Title: ISE 7.1i Project Navigator: Synplify flows do not support schematic sources.

Description: Projects using the Synplify design flows do not support schematics as 
sources. If a project with schematic sources is changed from another design flow to a 
Synplify design flow, the schematics will become user documents. 

Reference: Xilinx Answer Record #12081, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=12081

http://www.xilinx.com
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=12075
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17495
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17498
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20480
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=9186
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=12081
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The following issue pertains to Project Navigator w/ Schematic Sources:

Title: 7.1i Project Navigator: Switching Simulation Language for a Schematic project 
may cause XST to Fail.

Description: If a Schematic project is run, and then run again with the Simulation 
Language switch from to Verilog to VHDL or from VHDL to Verilog, XST synthesis 
will fail with FATAL_ERROR:Xst:Portability/export/Port_Main.h:127:1.13 - This 
application has discovered an exceptional condition from which it cannot recover. 
To avoid the error run the "Cleanup Project files" process.

Reference: Xilinx Answer Record #17491, or 
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17491

RocketIO Wizard
The following issue pertains to the RocketIO™ Wizard:

Title: ISE 7.1i RocketIOWizard - Usage of the GT11CLK module. 

Description: User should not check the GT11CLK option. This option will be removed 
in the forthcoming software release. The user is given the option of instantiating the 
GT11CLK module in order to make the clocking more flexible. Using the current 
wizard, if more than two clocks are required, the user can make manual edits to the hdl 
file created by Architecture Wizard. More details are provided in the reference. 

Reference: Xilinx Answer Record #17415, or 
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17415 

Simulation
The following issues pertain to Simulation:

1. Title: 7.1i ISE Simulator (ISIM) - Known issues with ISE Simulator.

Description: Xilinx Answer Record 20370 covers all Known Issues with the Xilinx ISE 
Simulator. Please Reference the Answer Record online for the most accurate 
information.

Reference: Xilinx Answer Record #20370, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20370

2. Title: ISE 7.1i COMPXLIB - When an older version of compxlib is run after the ISE 7.1i 
compxlib is run in the same directory, it errors out.

Description: When an older version of compxlib is run after the ISE 7.1i compxlib is 
run in the same directory, it errors out. 

The ISE 7.1i compxlib contains a new compxlib.cfg file. Compxlib has the ability to 
read the compxlib.cfg, if it exists in the current directory, and when an older version of 
compxlib is run, it not be able to understand the information in the compxlib.cfg file. 

To work around this problem, ensure that the new compxlib.cfg file has been deleted 
or renamed, prior to running the older version of compxlib.

Reference: Xilinx Answer Record #20372, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20372

3. Title: VCS - ISE 7.1i RAMB16 models errors out during compile in VCS_MX7.1.1.

http://www.xilinx.com
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20370
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20372
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17491
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17415
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Description: When trying to compile the RAMB16 models, it errors out with the 
following error message:

Assertion failed "0 && "Aggressive 2value optimization failed: x/z
unexpected in the result"" at line 1528 in file mop.c
Failure processing module X_RAMB16_S18_S18 in file 

This is a problem specific to VCS_MX7.1.1 and older releases. The problem is fixed in 
the VCS_MX7.1.2. Please contact Synopsys to get the latest version of VCS.

Reference: Xilinx Answer Record #20373, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20373

4. Title: ISE 7.1i/6.3i SmartModel, Simulation - Can I use Linux 64 with AMD Opteron 
machines with the Xilinx SmartModels?

Description: Synopsys does not have a native compiler for SmartModels on the Linux 
64 Opteron machines, therefore this is not currently possible. Synopsys is working on 
a fix for this problem, but there is no set release date.

Reference: Xilinx Answer Record #20374, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20374

Speedprint
The following issue pertains to Speedprint.

Title: ISE 7.1i Speedprint - Incorrect versions are reported unless Service Pack 1 is 
installed.

Description: Numerous issues with reporting have been seen with Speedprint in ISE 
7.1i. To make sure the correct numbers are being reported, please install Service Pack 1 
before using Speedprint.

Reference: Xilinx Answer Record #20513, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20513

Wind/U (Solaris and Linux)
The following issues pertain to the Wind/U registry:

1. Title: Wind/U - My GUI application appears to hang, or I receive a "WindU registry" 
error message on Solaris or Linux.

Description: This can be caused by corruption to GUI library files used in several 
Xilinx Workstation tools. To determine if a process is hanging, close any open Xilinx 
applications, and look for any running "windu_registryd44" processes.

To remove corrupt files before restarting the Xilinx application, do the following:

1. Halt "windu_registryd44" processes running using the following command:

kill -9 ’process ID number

2. In your home directory, run the following command:

rm -rf .windu*

Reference: Xilinx Answer Record #17321, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17321

2. Title: Wind/U - On Linux or Solaris, I receive the message “OLE API Function 
CoInitialize is not currently implemented. Further warnings will be suppressed.”

http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17321
http://www.xilinx.com
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Description: After launching the setup program from a Terminal Window, or 
launching any ISE GUI after installing the software, I receive the error "OLE API 
Function CoInitialize is not currently implemented. Further warnings will be 
suppressed." This is a false error generated by Wind/U and can be safely ignored.

Reference: Xilinx Answer Record #14348, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=14348

XPower
The following issues pertain to XPower:

1. Title: ISE 7.1i XPower Web Power Tool - The quiescent power values are different from 
information in the data sheets 

Description: The values quoted by XPower or the Web Power Tool for a design with no 
stimulus are not equal to the values quoted for quiescent supply current in the data 
sheets.

Reference: Xilinx Answer Record #13775, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=13775

2. Title: ISE 7.1i XPower - Device support list contains XBR, but not CoolRunner-II.

Description: When selecting the Device Support List from within XPower (Help → List 
Supported Devices), the CoolRunner-II family is missing, but there is an XBR family 
listed. What is XBR?

Reference: Xilinx Answer Record #17453, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=17453

3. Title: ISE 7.1i XPower - What power estimation tools are available for Virtex-4?

Description: Virtex-4 support is not available at time of ISE 7.1i release.

Reference: Xilinx Answer Record #20151, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20151

4. Title: ISE 7.1i XPower - Power is not temperature dependant.

Description: When ambient temperature is changed, the thermal characteristics 
change, but overall power does not. 

Reference: Xilinx Answer Record #20489, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=20489

5. Title: ISE 7.1i XPower - DCM quantity and frequency do not impact VccAux power.

Description: The VccAux power reported by XPower does not change with the 
number of Digital Clock Managers (DCM) in the design nor their operating frequency.

Reference: Xilinx Answer Record #18493, or
http://www.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=18493

XST
The following issue pertains to XST:

1. Title: ISE 7.1i XST - XST now has limited support for null arrays.

Description: With the release of ISE 7.1i XST, XST now has limited support of null 
arrays. This support has been improved in ISE 7.1i. In VHDL, a null array is any range 
that has no value.

http://www.xilinx.com
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Reference: Xilinx Answer Record #19716, or
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=19716

2. Title: ISE 7.1i XST - XST creates incorrect logic when using signed data types in Verilog.

Description: XST will improperly sign extend signed data type signals when signed 
and unsigned data type operands are used together in an operation.

Reference: Xilinx Answer Record #19139, or
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=19139

http://www.xilinx.com
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=19716
http://support.xilinx.com/xlnx/xil_ans_display.jsp?getPagePath=19139
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Chapter 4

Software Service and Support

This chapter describes how to contact Xilinx for Customer and Technical Services and 
Support and how to find up-to-date information about Xilinx® products. The following 
sections are in this chapter:

• “Technical Services and Support”

• “Software Customer Service”

• “Customer Education”

Technical Services and Support 
Please visit MySupport at http://www.xilinx.com/support/mysupport.htm for Xilinx 
technical services and support. Following are some of the features available from the 
website.

Global Services
Visit the Global Services website at http://www.xilinx.com/support/gsd/index.htm for 
information on Xilinx® Support Services, including Platinum and Titanium Technical 
Service, Design Services, Education Services, and the Xilinx Productivity Advantage (XPA) 
program.

Technical Support
Following are some of the support features available from the website:

MyAlerts and MyXPA

Log in to MySupport at http://www.xilinx.com/support/mysupport.htm, and select the 
categories that are most relevant to your needs. MyAlerts notifies you when information 
related to these categories is updated on the Xilinx website. MyXPA makes it quick and 
convenient to check your training credit status, sign up for classes, and much more.

Software Updates

Visit Software at http://www.xilinx.com/support/software.htm to access the latest 
software Service Packs and the Software Update Center.

TechXclusives

Visit TechXclusives at http://www.xilinx.com/xlnx/xweb/xil_tx_home.jsp to access 
design techniques straight from the industry's foremost application engineers.

http://www.xilinx.com
http://www.xilinx.com/support/mysupport.htm
http://www.xilinx.com/support/gsd/index.htm
http://www.xilinx.com/support/mysupport.htm
http://www.xilinx.com/support/software.htm
http://www.xilinx.com/xlnx/xweb/xil_tx_home.jsp
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Answer Records

Visit Advanced Search at http://www.xilinx.com/support/searchtd.htm to fine-tune 
your search query, or visit the Answers Database at 
http://www.xilinx.com/xlnx/xil_ans_browser.jsp to view Xilinx answer records. Use the 
answer records to help troubleshoot issues or find workarounds to common technical 
issues.

Software Manuals

Visit Software Manuals at http://www.xilinx.com/support/sw_manuals/xilinx7/ to 
access the Software Manuals and Help collection on the Web. The software manuals 
available from this collection provide detailed information about the ISE software 
applications and command line functions and are available for viewing in both PDF and 
HTML formats. The Help available from this collection provides procedural information 
for using the ISE software applications.

Note  The Libraries Guide and Constraints Guide on the Web are updated periodically 
with the latest device-specific information. Check the Software Manuals website for the 
most up-to-date information.

Forums

Visit Forums at http://toolbox.xilinx.com/cgi-bin/forum to access the following 
discussion groups:

• Xilinx General

• Spartan™-3 FPGA

• Virtex-II Pro™ Platform FPGA

• Forge High Level Language Compiler

• Embedded Processors

• XtremeDSP

• eSP Home Networking

• TechXclusives

• comp.arch.fpga

• Japanese Forum

Problem Solvers

Use the Xilinx® Problem Solvers at 
http://www.xilinx.com/support/troubleshoot/psolvers.htm to troubleshoot issues in 
the following areas: 

• Configuration

• Virtex-II™ configuration

• CPLD fitting

• JTAG

• Mapping

• ModelSim® simulation

• Peripheral Component Interface (PCI) configuration

• Timing

http://www.xilinx.com
http://www.xilinx.com/support/troubleshoot/psolvers.htm
http://www.xilinx.com/support/searchtd.htm
http://www.xilinx.com/xlnx/xil_ans_browser.jsp
http://www.xilinx.com/support/sw_manuals/xilinx7/
http://toolbox.xilinx.com/cgi-bin/forum
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WebCase

Visit WebCase at http://www.xilinx.com/support/clearexpress/websupport.htm to 
create a technical support case or to monitor the status of a case.

Contact Technical Support 
You can contact Xilinx for additional information and assistance as follows.

Technical Services and Support

The Xilinx website at http://www.xilinx.com/ contains thousands of online technical 
solutions and product information for Xilinx® software and devices. The website is 
updated daily with the latest patches, problem resolutions, application notes, and data 
sheets. Receive immediate answers 24 hours a day.

Technical Support WebCase and Hotline

If you cannot find your answers on the Xilinx website, use our online support tool, 
WebCase. If you are not able to contact support through WebCase, contact the Technical 
Support Hotline at one of the numbers listed in the following table. 

Note: For the most up-to-date contact information, visit the Technical Support Web page at 
http://www.xilinx.com/support/services/contact_info.htm.

Region Language Phone* WebCase Support Hours

North America EN 1 800-255-7778 or

+1 408-879-5199

Please open a case via 
WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 7:00 - 17:00 PST

Europe, Middle

East, and Africa

EN, DE, FR 00 800-5152-5152*** 
or 

+353 1-461-5700

WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 8:00 - 17:30 
GMT

Japan JP +81 3-5321-7750 Japan WebCase:
http://www.xilinx.co.jp/s
upport/clearexpress/webs
upport.htm

M-F 9:00 - 17:30 JST

Korea EN +82 2-3144-0255 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 10:00 - 19:00 
KST

China CH (Mandarin), 
EN

+86 21-3318-4505 China WebCase:
http://www.xilinx-
china.com/support/cleare
xpress/websupport.htm

M-F 9:00 - 18:00 CST

Taiwan  CH 
(Mandarin), EN

+886 2-8176-1060 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

http://www.xilinx.com/
http://www.xilinx.com
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/services/contact_info.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.co.jp/support/clearexpress/websupport.htm
http://www.xilinx-china.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
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Corporate Switchboard + 1-408-559-7778

* For the numbers listed, ’+’ represents the International Direct Dialing (IDD) prefix of the 
country from which you are calling. Consult your local telephone service provider for 
more information on the IDD codes for the country from which you are calling.

** Support Hours listed apply for both standard and daylight savings time. 

*** This toll free number is valid when dialing from the following countries: Austria, 
Belgium, Denmark, Finland, France, Germany, Ireland, Israel, Italy, Luxembourg, 
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, and the United Kingdom. 
When dialing from other countries, use the alternate number provided, which is charged at 
international direct-dial rates.

Education Services

Take advantage of the latest ISE software features! Go to the Xilinx website, and click 
Education to download e-learning modules and to sign up for updated ISE software 
training classes that help you maximize productivity and increase your skill set while 
lowering your overall development costs.

Order Management

Go to the Xilinx website and click Online Store, or contact your local Xilinx distributor for 
products and services available through Xilinx.

Software Customer Service
Visit http://www.xilinx.com/support/services/contact_info.htm to find sales and 
distributor contact information for your region. 

Hong Kong CH (Mandarin), 
EN

+852 3187-3855 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Singapore CH (Mandarin), 
EN

+65 6544-8998 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Rest of Asia CH (Mandarin), 
EN

+86 21-3318-4505 WebCase:
http://www.xilinx.com/
support/clearexpress/
websupport.htm 

M-F 9:00 - 18:00 CST

Region Language Phone* WebCase Support Hours

Country Telephone E-mail

North America 1-800-624-4782

408-879-6127

isscs@xilinx.com

Europe Please call your distributor: 
http://www.xilinx.com/company/
sales/int_reps.htm

m1license@xilinx.com

http://www.xilinx.com/company/sales/int_reps.htm
http://www.xilinx.com
http://www.xilinx.com/support/services/contact_info.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
http://www.xilinx.com/support/clearexpress/websupport.htm
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If you are an international customer, contact your local sales representative for customer 
service issues. A complete list of Xilinx worldwide sales offices is at:

http://www.xilinx.com/company/sales/offices.htm

Customer Education
Ways you can learn to use the Xilinx software tools, including using the software manuals 
and online help, taking a customer education course, or taking an online tutorial are as 
follows:

1. Training Classes

Xilinx offers specialized training modules and software update classes at many 
different locations. 

For more information about customer training classes and software training for Xilinx 
products, use the Xilinx Support website at:

http://www.xilinx.com/support/mysupport.htm

You can also contact a Xilinx Training Administrator at the following toll-free number: 

1-877-XLX-CLASS

International customers please contact your local sales representative or distributor for 
area-specific training programs.

2. User Tutorials

All tutorials on the Web can be found at:

http://www.xilinx.com/support/techsup/tutorials/index.htm

3. Software Manuals Online and Online Help

All manuals and Online Help on the Web can be found at:

http://www.xilinx.com/support/sw_manuals/xilinx7/index.htm

4. E-learning

This is a system that provides in-depth technical training sessions on Xilinx® 
programmable logic products over the Web. For more information, use the following 
website:

http://www.xilinx.com/support/training/e-learn_sched.htm

Japan +81-3-5321-7732 cs_1@xilinx.com

All Others 1-800-624-4782

1-408-879-6127

cs_1@xilinx.com

Country Telephone E-mail

http://www.xilinx.com
http://www.xilinx.com/company/sales/offices.htm
http://www.xilinx.com/support/mysupport.htm
http://www.support.xilinx.com/support/sw_manuals/xilinx7/index.htm
http://www.xilinx.com/support/training/e-learn_sched.htm
http://www.xilinx.com/support/techsup/tutorials/index.htm
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